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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Chapter 1

Configuring SiteScope to Communicate
with HPOM and OMi Overview

SiteScope, which is an agentless solution for IT infrastructure performance and availability
monitoring, can work together with Operations Manager (HPOM) andOperations Management
(OMi) in BSM, to provide a powerful combination of agentless and agent-based infrastructure
management.

SiteScope communicates with these applications using the HP Operations agent, which is installed
on the SiteScope server. The HP Operations agent enables SiteScope to integrate both event and
metrics data:

l Events. Events in SiteScope are based on SiteScopemonitor metric status changes and alerts
being triggered. SiteScope sends events by writing them to a log file which is monitored by the
HP Operations agent. The agent reads the data and converts it to events, which it forwards to
the HPOMmanagement server, or to BSM for use in Operations Management, Service Health,
and Service Level Management. For details on sending events, see "Configuring SiteScope to
Send Events to HPOM or OMi" on page 11.

l Metrics Integration. The HP Operations agent acts as a data storage for metrics data collected
by SiteScope. SiteScopemetrics are collected from the HP Operations agent data storage by
HPOM for use in PerformanceManager graphs, and by PerformanceGraphing in BSM's
Operations Management. For details on reportingmetrics, see "Configuring SiteScope to Report
Metrics to HPOM andOMi" on page 51.

Note:

l This integration replaces the need to install the HP SiteScope Adaptor on the HPOM server
that was required for the earlier integration solution when using the basic alert script
mechanism.

l Metrics integration using the HP Operations agent (wheremetrics data is used in
PerformanceGraphing in BSM's Operations Management) should not be confused with the
BSM integration where SiteScopemonitor metrics are used by the various BSM
applications to calculate CI status (for example, in Service Health, Service Level
Management, and System Availability Management). For details on BSMmetrics
integration, see theWorking with BSM section of the Using SiteScopeGuide in the
SiteScope Help.

Tip: For best practices and troubleshooting for reporting data to BSM andHPOM products, see
the Integration with BSM andHPOM Best Practices guide in the SiteScope Help.
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Event and Metrics Flow Diagram
The following diagram illustrates themetrics data and event flow between SiteScope and the
HPOM and BSM applications.

HP Operations Agent Topology
HP Operations agent CIs are created when SiteScope is connected to HPOM, and HPOM is
connected to BSM.

When SiteScope is connected directly to BSM, SiteScope creates the agent CI through its usual
topology flow. When SiteScope sends its main topology (profile CI) and there is either an event or
metrics integration with Operations Manager active, it also sends the agent topology.

Note:

l The agent CI is deleted only when both event andmetrics integrations are removed.

l The agent CI is not deleted when SiteScope is disconnected from BSM, because
SiteScope does not know if the connection is through HPOM or BSM (the agent CI
eventually disappears due to the aging process).
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Centralized Template Management from
HPOM

This integration enables you to centrally manage and deploy templates frommultiple SiteScope
instances from within HPOM (this is not relevant when SiteScope is integrated with Operations
Management).

Benefits

This integration provides the following benefits:

l Centralizedmanagement of templates across multiple SiteScope instances—you no longer
have to worry about templates getting out of sync or to manually sync templates.

l Version control for templates (including roll-back functionality).

l Automatic and robust deployment of templates based on group policy assignment (desired state
handling).

l Scheduled roll out of template deployment.

l Reduced firewall configuration, leveraging existing HP Operations agent-HPOMmanagement
server connectivity.

l Unifiedmanagement of SiteScope and the HP Operations agent through a single administrative
console.

Note: This integration is currently not supported for HPOM forWindows.

Available Actions

Whenmanaging SiteScope templates with HPOM, you can perform the following actions:

l Export all templates from SiteScope and import them to HPOM as policies, which you can later
on assign and deploy. Use theExport to OM option in the Template shortcut menu in SiteScope
to export SiteScope templates to HPOMwhen SiteScope and HPOM are installed on the same
machine.

l Create or modify a template on SiteScope and thenmove this template to HPOM (only when
SiteScope and HPOM are installed on the same system). This means that you can either create
a new template or modify an existing template to contain the text or the variables that you
choose.

l Deploy a SiteScope template or import template container from HPOM.

l Delete SiteScope templates.

Note:When deploying a template to SiteScope from HPOM, all mandatory SiteScope
variables must have a value set in the OM Policy. If not, the deployment fails.
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For details onmanaging SiteScope templates with HPOM, seeDeploying SiteScope Configuration
with HPOM, available from the Home page of the SiteScope Help, or from the HP Software Support
Product Manuals site (underOperations Manager for UNIX).

System Requirements

Template integration with HPOM is available provided your system conforms to the following
requirements:

l SiteScope is installed and connected to a supported version of HPOM. For the HPOM versions
supported in this release, see the HP Operations Manager (HPOM) Integration Support Matrix in
the SiteScope release notes (in SiteScope, select Help > What's New?).

l Before installing SiteScope, you should create a predefined SiteScope configuration with a
defined username and password for the SiteScope Administrator. For details, seeDeploying
SiteScope Configuration with HPOM, available from the Home page of the SiteScope Help or
from the HP Software Support Product Manuals site (underOperations Manager for UNIX).

l The HP Operations agent is installed on the SiteScope server using the SiteScope Configuration
Tool (even if the agent was previously installed during SiteScope installation). For details on
installing the agent using the Configuration Tool, see “Using the SiteScope Configuration Tool”
in the SiteScope Deployment Guide.

l Operations Manager integration is configured in SiteScope and theEnable exporting
templates to HP Operations Manager check box is selected in HP Operations Manager
IntegrationMain Settings. For details, see "How to Enable SiteScope to Send Events to HPOM
or OMi" on page 15.

SiteScope Failover and Operations Manager
Integration

The SiteScope Failover (automatedmirroring) solution was reinstated in SiteScope as a
replacement for the SiteScope Failover Manager (shared drive architecture) solution for providing
automated failover functionality. SiteScope Failover provides support for Operations Manager event
andmetrics integration. If you want to configure HP Operations Manager Integration for SiteScope
with High Availability option, the SiteScope Failover solution is recommended, since HP might stop
supporting the Failover Manager solution in the future.

Event Integration

To enable SiteScope Failover support for OM event integration, perform the steps in "How to
Enable SiteScope to Send Events to HPOM or OMi" on page 15, both for the primary SiteScope
and for the SiteScope Failover.

Event flow and host discovery flow work without any additional steps. For theMonitor Discovery
integration, follow the steps in "How to Enable the SiteScopeMonitor Discovery Policy" on page 27
for the primary SiteScope only.
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Notes and Limitations

l Since there will be only one SiteScope service tree (and it is affected by events), it is not
possible to know if it is affected by what was reported from the primary or failover SiteScope.

l When the primary is down, events triggered frommonitors that aremonitoring the SiteScope
server (in this case, the SiteScope server is the failover) do not affect the service tree.

l Groups andmonitors added when the primary is down are not displayed in the service tree.

l The Drill Down to SiteScope tool works only when the primary SiteScope is running.

l If there are different agent configurations on the primary and SiteScope Failover (for example, an
agent is installed on a different path), the agent command on the failover server will not run from
the Event Integration preferences user interface and you need to enter the agent pathmanually
beforehand.

Metrics Integration

SiteScope Failover provides support for OMmetrics integration. Note that SiteScope Failover
reports metrics to its HP Operations agent (not to the primary's agent).
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Chapter 2

Configuring SiteScope to Send Events to
HPOM or OMi

You can enable SiteScope to send events directly to the HPOMmanagement server and to BSM
(for use in Operations Management, Service Health, and Service Level Management). Events in
SiteScope are based on SiteScopemonitor metric status changes and alerts being triggered.

To enable SiteScope to send events, the HP Operations agent must be installed on the SiteScope
server. The agent can be installed from the SiteScope installationmedia during SiteScope
installation, or after SiteScope is installed using the Configuration Tool. It can also be installed
manually from the HPOMmanagement server, although this is not recommended unless it is the
same or a later version than the one packaged with SiteScope.

After the agent is installed, it must be configured in SiteScope Integration Preferences. This
involves entering the installation path of the agent and the host name or IP address of the HPOM
management or BSMGateway Server, and connecting the agent to HPOM or BSM. The agent then
sends a connection request to HPOM or BSM whichmust grant the certificate request (the HPOM
management server can be configured to accept this client automatically).

After the certificate request has been granted on the HPOM or BSM server, a preconfigured log file
policy should be installed and signed on the agent installation on the SiteScope server. This
enables SiteScope to sign the preconfigured Operations Manager policies locally and automatically.
This policy comes with SiteScope, and is deployed from theOperations Manager Integration dialog
box in SiteScope's Integration Preferences.

When an event is triggered, SiteScope writes the event data to the
HPSiteScopeOperationsManagerIntegration.log file which is located in the <SiteScope root
directory>\logs directory. Each event is written as a separate line in the log. The log file policy
instructs the agent to read this file and create event messages that are sent to HPOM or BSM.

The format of the event attributes is determined using the event mapping template. The template
maps SiteScope runtime data to the event attribute values that are sent to the HPOMmanagement
or BSMGateway Server when an event is triggered. For details on event mappings, see the section
on Common Event Mappings in the Using SiteScopeGuide in the SiteScope Help.

After the data is converted to an event, the agent sends the event to the HPOMmanagement/BSM
Gateway Server. Events appear in:

l HPOM's Event Console.

l BSM's Operations Management Event Browser if you have an Event Management Foundation
license, and in Service Health for events that affect CIs. If Operations Management is not part of
your BSM installation, you can still view events that affect CI status using a health indicator in
Service Health.
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The following diagram illustrates event data flow:

Note: The HP Operations agent can be configured either to report events to an HPOM
management or a BSMGateway Server—not to both.

For details on configuring SiteScope to send events, see "How to Enable SiteScope to Send
Events to HPOM or OMi" on page 15.

Event Generation
You can configure events to be generated and sent to the HPOMmanagement server or to
Operations Management in BSM following a change in amonitor's metric status or when a
SiteScope alert is triggered.

l Status Change. Every metric or counter status change is an event (for example, if the CPU
utilization counter status changes from Good to Error). You can choose whether events are
triggered for metrics status changes in themonitor's properties. By default, SiteScope sends an
event for eachmetric status change for themonitor instance.

You can change the default settings for sending events and the event attribute values used
when an event is triggered. The event attribute values are filled according to the event
configurationmappings using themonitor's properties. For details on event mappings, see the
event mapping section in the Using SiteScopeGuide in the SiteScope Help.
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In addition to sending themonitor properties, SiteScope also sends health indicators or event
type indicators (indicators) for themonitor instance. Events are categorized according to
indicators. The BSM event manager uses indicators to categorize events according to the type
of occurrence in themanaged IT environment (for example, CPU Load). Indicators that provide
CI state information are then used to calculate the CI.

Note: Status change is applicable only to metrics that are configured in themonitor's
Thresholds Settings.

l Alert. Every alert is an event. Since alerts are triggered per monitor, an event triggered by an
alert can use themonitor's properties, but not the indicators associated with a specific metric.
Therefore, when configuring an event alert, you canmanually select the indicator that is reported
when an event is triggered by an alert. As a result, the indicator is more generic, and you should
select indicators that do not affect health indicators in BSM.

You can choose whether an alert sends events to HPOM or BSM in the alert definition in the
Operations Manager Integration Settings panel.

Note:

n When a SiteScope alert is triggered, it is possible that two events are generated if both
the alert andmonitor are configured to send events. When configuring alerts to send
events, you should not also enable themonitors to send events. Conversely, if you want
an alert for eachmetric status change (together with health or event type indicators for
themonitor instance), we do not recommend also using alert events.

n SiteScope also includes threshold information in alerts that are sent to HPOM. In earlier
versions of SiteScope and BSM, it was not possible to include the thresholds created for
monitors in alerts.

n In Operations Management, it is recommended to use alert events for notification
purposes only.

Discovery Scripts and Drilling Down User to
View HPOM Events

When SiteScope is integrated with HPOM, theNode discovery and Monitor discovery
policies are activated for nodes andmonitors on the HPOMmanagement server.

Both discovery policies rely on the Integration Viewer user in SiteScope. This is the user
provided by SiteScope for drilling down from HPOM events. This user has been granted view
permissions, and permissions to refresh groups andmonitors. For details on users and user
permissions, see section on user management preferences in the Using SiteScopeGuide in the
SiteScope Help.

Note:

n If the Integration Viewer user is deleted from UserManagement Preferences, this user
type is automatically created when SiteScope is restarted.
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n If the Integration Viewer user properties are changed, youmust restart SiteScope to
update the user properties file, or you canmanually update the user properties in the
<SiteScope root directory>\conf\sitescope_connection.properties file.

When changing Integration Viewer user properties manually, the user login name and
password should be encrypted using the SiteScope Encryption Tool as follow:

i. Run the following batch file:

o For Windows: <SiteScope root

directory>/tools/AutoDeployment/encrypt_password.bat

o For UNIX: <SiteScope root

directory>/tools/AutoDeployment/encrypt_

password.sh<SiteScope

ii. Open a command prompt window.

o InWindows, drag and drop the file into your command prompt window.

o In UNIX, youmust run the .sh file from its directory.

iii. Enter space and the password value (for example Mypassword). Click Enter.

iv. Use the returned string as a value for the encrypted variable in the XML file. You
much change the value of the attribute encrypted to yes and the value of the
variable attribute to the returned string.

For example, the following value was generated by the encryption tool:
<deploy:variables encrypted="yes" name="password" value="

(sisp)d5JLOSWaVfE="/>

For details on deploying the discovery policies on the HPOMmanagement server, refer to the
HPOM documentation.

Node Discovery Policy
When SiteScope is connected with HPOM, a node is automatically created and registered in
HPOM for each nodemonitored by SiteScope. This enables SiteScope to report all the nodes
that it monitors to HPOM. Only hosts for monitors which report events are sent to HPOM
through the discovery policy.

Tip:When you are not connected to HPOM (if connected to Operations Management), it is
recommended to disable the node discovery by running the command: ovpolicy -

disable -polname SiteScope_Hosts_Discovery

Note: SiteScope does not report nodes or services to HPOM for monitors that are disabled,
or are not configured to send events.
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Monitor Discovery Policy
This is an optional policy that must be activatedmanually on HPOM using the files in the
<SiteScope root directory>\tools\OMIntegration\
SiteScopeMonitorDiscoveryPolicy directory. After the policy has been activated, SiteScope
runs the SiteScope-OMmonitor discovery script when it is connected with HPOM.

This policy enables the HPOM Service Navigator to view the SiteScopemonitor tree in the
HPOM servicemaps. When new monitors, groups, or both, are added or changes aremade in
the SiteScopemonitor tree, the services tree is updated in HPOM to reflect these changes. In
addition, when events arrive to HPOM, they affect the SiteScope services tree and color all
related nodes affected by them.

For details on how to enable themonitor discovery policy, see "How to Enable the SiteScope
Monitor Discovery Policy" on page 27.

For details on enabling the tool to drill down to SiteScope from HPOM, see "How to Enable the
Drill Down to SiteScope Tool on HPOM forWindows" on page 24 and "How to Enable the Drill
Down to SiteScope Tool on HPOM for UNIX/Linux/Solaris" on page 25.

How to Enable SiteScope to Send Events to
HPOM or OMi

This task describes how to enable SiteScope to be used to send events to the HPOMmanagement
server or BSMGateway Server.

1. Prerequisites
n Your systemmust conform to the following requirements:

o SiteScope version 11.00 or later is installed.

o For OMi, BSM 9.00 or later is installed.

o For HPOM, HP Operations Manager for UNIX 9.0x, or HP Operations Manager for
Windows 8.1x is installed.

Note: The node discovery, monitor discovery, and template integration are not
supported for all versions of HPOM. For details of the integrations that are supported
and of any patch requirements, refer to the HP Operations Manager (HPOM)
Integration Support Matrix in the SiteScope release notes. (Available from the HP
Product Manuals site (http://support.openview.hp.com/selfsolve/manuals).

n Only a SiteScope administrator user, or a user grantedEdit integration preferences and
Add, edit or delete common event mappings permissions can configure the integration
and event mappings. For details on user permissions, see the section on user management
preferences in the Using SiteScopeGuide in the SiteScope Help.

2. Install the HP Operations agent on the SiteScope server
You can install the HP Operations agent during SiteScope installation from the SiteScope
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installationmedia, or after SiteScope is installed using the Configuration Tool. The agent
enables SiteScope to send event data to the HPOMmanagement server or BSMGateway
Server.

For the supported HPOM environments and HP Operations agent versions, refer to the HP
SiteScope Support Matrices section in the SiteScope release notes.

For details on installing the agent during SiteScope installation or using the SiteScope
Configuration Tool, see the HP SiteScope Deployment Guide.

3. (For OMi only) Configure the connection request to be passed to the
Data Processing Server if BSM is installed on a distributed
environment, or if BSM Gateway Servers are behind a load balancer
If BSM uses a separate Gateway and Data Processing Server, perform the following to enable
the request received on theGateway Server to be passed to the Data Processing Server:

a. In BSM, select Admin > Platform > Infrastructure Settings:

o Select Applications.

o Select Operations Management.

o In theCertificate Server Settings, locate theCertificate Server Host. Make sure that
the valuematches the host name or IP address of the active BSM Data Processing
Server that acts as the certificate server host. If it does not match, change it
accordingly.

Note: If the BSM Data Processing Server fails and automatic failover has been
configured, youmust change theCertificate Server Host setting to the name of
the backup Data Processing Server to handle new certificate requests. However, if
you do not expect any new certificate requests during the Data Processing Server
failover timeframe, you can keep the setting unchanged as it does not affect any
event integrations configured previously.

b. Configure the Gateway Server:

o Change the active directory to the \bin directory by typing cd <HPBSM root

directory>\bin.

o Run setup-secure-communication.bat and enter the DNS name of the Data
Processing Server.

c. Configure the Data Processing Server:

o Change the active directory to the \bin directory by typing cd <HPBSM root

directory>\bin.

o Run setup-secure-communication.bat and type g to grant the request (make sure that
you grant this request and not some other request).

d. If you are using a BSM failover environment with load balancer, make sure to keep the
certificate server of each Data Processing Server synchronized.

o Repeat steps b and c for every Gateway Server. It does not matter to which Data
Processing Server you send the certificate request because the Data Processing
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Servers already trust each other. As a result, all Gateway Servers trust both Data
Processing Servers and can communicate with them regardless of which one is active
at any givenmoment.

o If you install a new certificate on the running Data Processing Server, you also have to
install the certificate on the secondary Data Processing Server which is used as
failover. To install the new certificate, run the following commands:

ovcert -importtrusted -file <newCertificateFilePath>

ovcert -importtrusted -file <newCertificateFilePath> -ovrg

server

o Configure the load balancer to forward all HTTPS traffic that arrives on port 383 to the
Gateway Servers. This enables the certificate requests and event forwarding to work.

4. Configure the agent connection settings on the SiteScope server
In SiteScope Integration Preferences, configure the HP Operations agent connection settings
to the HPOMmanagement server or BSM server.

a. Select Preferences > Integration Preferences. In the Integration Preferences page:

o Click theNew Integration button and select HP Operations Manager
Integration, or

o Select an existing integration and click theEdit Integration button.

b. In the HP Operations Manager Integration dialog box, expand theHP Operations
Manager Integration Main Settings panel, and enter the following in theConnection
Settings area:

o HP Operations Agent installation path. Path to the HP Operations agent installation
on the SiteScopemachine.

o OnWindows platforms, the installation path is automatically resolved from the HP
Operations agent InstallDir key in the registry, and appears in this field. The default
path is C:\Program Files\HP\HP BTO Software\. If the key is not found, the field is
left empty, and youmust manually enter the agent installation path.

o OnUNIX platforms: SiteScope checks to see if the HP Operations agent is installed
in the default /opt/OV path. If it is not there, the field is left empty, and youmust
manually enter the agent installation path.

Click theResolve Path button to restore the default installation path found by
SiteScope if youmanually entered a different path.

o HP Operations Manager/BSM server. Enter the name or IP address of the
HPOM/BSM server to which you want to connect. If you are connecting to a BSM-
distributed environment, enter the BSMGateway Server name or IP address. If your
BSMGateway Servers are behind a load balancer, enter the name or IP address of the
load balancer that is configured for data collectors.

c. Click Connect to connect the agent to the HPOMmanagement or BSM server. This sends
a connection request from the agent to the specified server.

HP SiteScope (11.20)Page 17 of 62



Integration with HP Operations Manager Products
Chapter 2: Configuring SiteScope to Send Events to HPOM or OMi

5. Accept the agent connection request on the HPOMmanagement
server or BSM Gateway/Web Processing server
n For HPOM:

In HPOM, you need to configure the SiteScope node, map the certificate request to this
node, and accept the certificate request.

i. In HPOM, add SiteScope as amanaged node.

o For HPOM forWindows, you can use the ovownodeutil command-line tool to add
a node, or you can use the user interface. For details, see the "Configure nodes"
section in the HPOM forWindows documentation.

o For HPOM for UNIX/Linux, you can use the opcnode command-line tool to add a
node.

Example - Using the opcnode command line tool:

# opcnode -add_node node_name=<SiteScope_node_name>

\net_type=<network_type> mach_type=<machine_type>

\group_name=<group_name> node_type=<node_type>

For detailed information, see the HPOM for UNIX and Linux documentation:

o "Adding aManaged Node to the HPOMDatabase" in the Administrator’s
ReferenceGuide.

o "Install HPOM Software on HTTPS Nodes" and "Working with Certificates" in
the HTTPS Agent Concepts and Configuration Guide.

ii. List the pending certificate request IDs with the following command. If you want that
detailed information on every pending request is listed, use the -l option:

ovcm -listpending [-l]

Note the request ID for the SiteScope node.

For more information, see the ovcmmanual page.

iii. Grant the certificate request from the to the SiteScope node, with the following
command:

ovcm -grant <SiteScope_node_request_id>

n For BSM:

For BSM running on aGateway Server only, perform the following on the BSMGateway
Server. If BSM runs on a distributed environment, perform the following on the Data
Processing Server.

i. (Optional) Tomake sure that the OV Certificate Server process is running, run the
command line run ovc -status. If it is not running, run the command ovc -

start or contact your BSM administrator.

ii. Change the active directory to the \bin directory by typing cd <HPBSM root

directory>\bin.
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iii. Run setup-secure-communication.bat and type g to grant the request (make sure
that you grant this request and not some other request).

iv. Make sure that the request ID you are going to accept is associated with the agent's
core ID. To retrieve the agent's core ID, in SiteScope, click theAnalyze button in HP
Operations Manager Integration, or run the agent's ovcoreid command on the
SiteScope server.

6. Install the log policies on the SiteScope server
After the certificate request has been granted on the HPOM/BSM server, click Install Policies
in the HP Operations Manager Integrations Main Settings panel of the HP Operations
Manager Integration dialog box. This installs and signs the preconfigured log file policy file on
the HP Operations agent.

Note: If an agent is connected to an HPOM or BSM server and you want to connect it to a
different server, youmust uninstall and reinstall the agent or redirect the agent to another
server. For task details, see "How to Reconnect the HP Operations Agent to a Different
HPOM or BSM Server" on page 22.

7. Check connection status and send test message from the SiteScope
server - optional
If there are connectivity problems, you can perform problem analysis and check the status of
the agent and the certificate request.

a. In the HP Operations Manager Integration dialog box, expand theHP Operations
Manager Integrations Main Settings panel, and click Analyze.

Use the information supplied in the analysis results to perform problem analysis and for
troubleshooting. For example, you can verify connectivity between the agent and server by
checking the bbcutil connection protocol.

b. To check that the agent is connected to the HPOMmanagement or BSM server, expand
theHP Operations Manager Integrations Advanced Settings panel, type amessage in
the Test message text box, and click Send Test Message.

c. If the test is successful, the text message is displayed in the HPOM console or in the
Operations Management Event Browser in BSM. This message is generated by a basic
opcmsg policy command.

8. (For HPOM only) Extend the integration with HPOM using monitor
discovery - optional
To enable the HPOM Service Navigator to view SiteScope groups andmonitors in the HPOM
servicemaps, youmust manually enable theMonitor discovery policy on HPOM using the files
in the <SiteScope root
directory>\tools\OMIntegration\SiteScopeMonitorDiscoveryPolicy directory.

For details on how to enable the policy, see "How to Enable the SiteScopeMonitor Discovery
Policy" on page 27.

Note: To enable SiteScope Failover support for the Operations Manager event integration,
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follow the steps for configuring themonitor discovery policy in "SiteScope Failover and
Operations Manager Integration" on page 9.

Tip: You can also use the Drill Down to SiteScope tool to enable opening the SiteScope
user interface from themonitor or group service that was discovered by themonitor
discovery policy and added to the HPOM Service Navigator.

n For details on enabling the tool on HPOM forWindows, see "How to Enable the Drill
Down to SiteScope Tool on HPOM forWindows" on page 24.

n For details on enabling the tool on HPOM for UNIX/Linux/Solaris, see "How to Enable
the Drill Down to SiteScope Tool on HPOM for UNIX/Linux/Solaris" on page 25.

9. Enable SiteScope to send events to HPOM or OMi
a. In the HP Operations Manager Integration dialog box, expand theHP Operations

Manager Integrations Main Settings panel, and in theConfiguration Settings area
select Enable sending events.

b. Configure the following settings as required:

o Connect directly to BSM. When the agent is connected to OMi, select to
automatically deactivate the node discovery policy if it was installed and enabled on the
SiteScope server. When this option is selected:

o TheEnable node discovery policy option is not available, and the node discovery
policy is disabled if it was installed and enabled on the SiteScope server.

o ThePrefer events over metrics in BSM Service Health (global preference)
option is automatically selected.

o Prefer events over metrics in BSM Service Health (global preference).
Determines the global default preference for influencing BSM's Service Health when
both SiteScope events andmetrics are reported to Service Health (since indicators for
SiteScope events andmetrics both affect CIs). This is relevant only when both BSM
andOperations Manager integrations are active, and are connected to the same BSM
server (the BSM server is used instead of the HPOM server).

If selected, theEvents option is set as the default preference for every new monitor
created inHP Integration Settings > BSM Service Health Preferences > BSM
Service Health affected by. If not selected,Metrics is the default preference for
reporting data to BSM. By default, this is not selected, whichmeans metrics data
influences Service Health.

Note: This setting does not override the preference already set for individual
monitor instances in themonitorProperties tab > HP Integration Settings >
BSM Service Health Preferences > BSM Service Health affected by box.

For more information on choosing the preference to use, see the section on integrating
SiteScope with BSM in Integration with BSM andHPOM Best Practices in the
SiteScope Help.
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o Enable node discovery policy. SiteScope enables the node discovery policy (if
installed) on the SiteScope server. This option is automatically selected when the
Connect directly to BSM option is cleared. For details on Node discovery, see
"Discovery Scripts and Drilling DownUser to View HPOM Events" on page 13.

o Enable exporting templates to HP Operations Manager. Enables exporting all
templates from SiteScope and importing them to HPOM as policies (only when
SiteScope and HPOM are installed on the same system), which you can later on assign
and deploy from HPOM. For details on the template integration with HPOM, see
"Centralized TemplateManagement from HPOM" on page 8.

10. Enable default event severity mappings to be used - optional
Severity mappings correlate the severity level in HPOM or BSM to themonitor threshold status
in SiteScope. You can use the default severity mappings or customize themapping between
the Error, Warning, Good, and Unavailable status threshold for eachmonitor instance in
SiteScope and the HPOM/BSM server in theHP Operations Manager Integrations
Advanced Settings panel.

If Use default severity is selected, the default mappings are sent when:

n Events are created by a triggered alert.

n SiteScope is not connected to BSM.

n The indicator state and severity value is missing. For example, when usingmonitors that do
not have a defined topology.

Note:

n This option is not available when SiteScope is connected to BSM (and the default
global severity mappings cannot be sent).

n By default, the Warning state is mapped to Minor (not Warning).

Note: You can override the severity mapping at themonitor level by modifying the
Severity attribute in Common Event Mappings. For details, see "Configure event
mappings for monitors and alerts - optional" on next page.

11. Enable/Disable sending events for monitor instances and alerts
By default, each newly-createdmonitor instance is configured to send an event for eachmetric
status change, and each new alert is configured to send an event when triggered. Monitors and
alerts that are upgraded from earlier versions of SiteScope are not configured to send events.

n To disable sending events when there is a change of ametric status
(Good/Warning/Error/Unavailable) for amonitor instance, in themonitor properties for the
selectedmonitor instance, expandHP Integration Settings > HP Operations Manager
Integration Settings, and clear theSend events check box. Status change is only
applicable onmetrics that are configured in themonitor's Threshold Setting.

n To disable sending events for an alert, in the New/Edit Alert dialog box, expand the HP
Operations Manager Integration Settings panel, and clear theSend events check box.
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Note: TheSend events option is selected by default when event integration is enabled in
the HP Operations Manager IntegrationMain Settings panel (otherwise this option is not
available).

12. Configure event mappings for monitors and alerts - optional
Monitor instances and alerts are assigned a common event mapping that is used when an
event is triggered. This is themapping between SiteScope runtime data and the values of the
attributes of the event that will be sent.

You can use the default event mapping associated with themonitor or alert, select a different
event mapping (if any exist), or create a new event mapping inPreferences > Common
Event Mappings. Alternatively, for alerts, you can use the event mapping template associated
with themonitor that triggered the alert.

You can select the event mapping template:

n When configuring amonitor instance from themonitorProperties tab > Event Mapping
Settings.

n When configuring alerts from theAlerts tab > New/Edit Alert > HP Operations Manager
Integration Settings > Event mapping.

For details on configuring Common Event Mappings, see "How to Configure Common Event
Mappings for HPOM or BSM" on page 30.

13. Results
After amonitor metric status change or an alert is triggered in SiteScope, the event is written to
the integration log file in the format selected for themonitor instance or alert in Common Event
Mappings.

The agent monitors the log file and creates an event, which it sends to HPOM or BSM. Events
are displayed in the Event Console in HPOM, or in BSM in the Operations Management Event
Browser (if you have an Event Management Foundation license). If Operations Management is
not part of your BSM installation, you can view events that affect CI status using a health
indicator in Service Health.

For notes and limitations on event integrations, see "Notes and Limitations" on page 39.

For troubleshooting event integration issues, see "Troubleshooting Event Integration Issues"
on page 40.

How to Reconnect the HP Operations Agent to
a Different HPOM or BSM Server

You can reconnect the HP Operations agent to a different HPOMmanagement or BSM server by
either:

l Uninstalling and reinstalling the HP Operations agent.

l Redirecting the HP Operations agent to a different server.
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Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to
Send Events to HPOM or OMi" on page 15.

To uninstall and reinstall the HP Operations agent:
1. In SiteScope, select Preferences > Integration Preferences, and delete the Operations

Manager integration.

2. Open the SiteScope Configuration Tool (Start > Programs > HP SiteScope >
Configuration Tool), select theHP Operations Agent option, and uninstall the HP
Operations agent.

3. Open the SiteScope Configuration Tool, select theHP Operations Agent option, and install
the HP Operations agent.

4. In SiteScope, configure the HP Operations Manager integration with the new HPOM/BSM
server to which you want to connect. For details, see "Configure the agent connection settings
on the SiteScope server" on page 17.

Note: After reconnecting to the HPOM server, it can take some time until events are sent
to HPOM. Restarting the HPOM server, the HP Operations agent, or both, might fix it.

To redirect the HP Operations agent to a different server:

Note: If you are cloning amachine with an HP Operations agent which usually includes a host
name and IP address change, start from step 1 below; otherwise start from step 4.

1. On the SiteScope server where the HP Operations agent is installed, run the following
command to create a new core ID:

ovcoreid -create -force

2. To remove the certificates, run:

ovcert -list

For all IDs in the output, run the command:

ovcert -remove 'id'

3. Adapt the xpl configuration variable OPC_NODENAME by running the command:

ovconfchg -ns eaagt -set OPC_NODENAME 'hostname'

4. Set the new server host name and core ID by running the commands:

ovconfchg -ns sec.cm.client -set CERTIFICATE_SERVER <new OM server>

ovconfchg -ns sec.core.auth -set MANAGER <new OM server>

ovconfchg -ns sec.core.auth -set MANAGER_ID <new OM server

ovcoreid>

ovconfchg -ns eaagt.lic.mgrs -set general_licmgr <new OM server>

ovconfchg -ns sec.cm.certificates -set CERT_INSTALLED FALSE
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5. Restart the HP Operations agent by running the commands:

ovc -kill

ovc -start

6. Create a new certificate request by running the command:

ovcert -certreq

7. Grant a certificate request on the HPOM or BSMGateway Server (in case of distributed BSM,
grant certificate request on the Data Processing Server).

8. In SiteScope, open theOperations Manager Integration dialog box and perform the following in
theHP Operations Manager Integration Main Settings panel:

n Change the name or IP address of the HPOM/BSM server in theHP Operations Manager /
BSM server box. For details, see "Configure the agent connection settings on the
SiteScope server" on page 17.

n Install the log policies by clicking the Install Policies button.

Note: After reconnecting to the HPOM server, it can take some time until events are sent
to HPOM. Restarting the HPOM server, the HP Operations agent, or both, might fix it.

How to Enable the Drill Down to SiteScope
Tool on HPOM for Windows

This task describes how to enable the Drill Down to SiteScope tool on the HPOM forWindows
management server. This tool enables you to open the SiteScope user interface from themonitor or
group service that was discovered by themonitor discovery policy and added to the HPOM Service
Navigator.

Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to
Send Events to HPOM or OMi" on page 15.

1. Prerequisites
TheMonitor Discovery policy must be enabled and deployed on the SiteScope Server node on
HPOM.

For task details, see "How to Enable the SiteScopeMonitor Discovery Policy" on page 27.

2. Install the Drill Down to SiteScope tool on the HPOM for Windows
server
a. Log on to the HPOM forWindows server machine as an Administrator.

b. Copy the drillDownToSiteScope.vbs file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMW folder to
\\<HPOM server>\SPI-Share\SiteScope.

c. Upload the Drill Down to SiteScope tool to the HPOM server:
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o Copy the tls_drillDownToSIS.mof file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMW folder to any folder
on the HPOM server machine (<tls path>).

o Open a command line and run the command:

>> ovpmutil cfg tls upl <tls path>\tls_drillDownToSIS.mof

d. The Drill Down to SiteScope tool is available on the HPOM server under Tools >
SiteScope Tools.

3. Associate the tool with the SiteScope Service
a. In the HPOM forWindows console, open the Service Type Configuration Editor, select

Application Services > SiteScope, and click Properties.

b. In the SiteScope Properties dialog box, click the Tools tab, select SiteScope Tools, and
then click OK.

4. Launch the tool (from the SiteScope service)
a. In the HPOM forWindows console, right-click the SiteScope service that you want to view

(SiteScopemonitor, group, or server service), and select All Tasks > Launch Tool.

b. Select theDrill Down to SiteScope tool, and click Launch.

c. The SiteScope user interface opens displaying the selectedmonitor, group, or the default
Dashboard view (if SiteScope Server service was selected).

5. Launch the tool (from the Tools repository)
a. In the HPOM forWindows console, expand Tools > SiteScope Tools. In the right pane,

right-click theDrill Down to SiteScope tool and select All Tasks > Launch Tool.

b. In the Edit Parameters dialog box, select themonitor, group, or SiteScope Server service
that you want to view, and click Launch.

c. The SiteScope user interface opens displaying the selectedmonitor, group, or default
Dashboard view (if SiteScope Server service was selected).

How to Enable the Drill Down to SiteScope
Tool on HPOM for UNIX/Linux/Solaris

This task describes how to enable the Drill Down to SiteScope tools on the HPOM for
UNIX/Linux/Solaris management server. This tool enables you to open the SiteScope user
interface from events or from themonitor or group service that was discovered by themonitor
discovery policy and added to the HPOM Service Navigator.

Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to
Send Events to HPOM or OMi" on page 15.

1. Prerequisites
TheMonitor Discovery policy must be enabled and deployed on the SiteScope Server node on
HPOM.
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For task details, see "How to Enable the SiteScopeMonitor Discovery Policy" on next page.

2. Install the Drill Down to SiteScope tools on the HPOM for
UNIX/Linux/Solaris server
a. Log on to the HPOM for UNIX/Linux/Solaris server machine as an Administrator.

b. Open a command shell and create a new directory by typing:

# mkdir -p /opt/OV/newconfig/SiteScope

c. Change to the SiteScope directory by typing:

cd /opt/OV/newconfig/SiteScope

d. Copy theDrillDownToSIS.tar file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMX folder to
/opt/OV/newconfig/SiteScope on the HPOM server machine.

e. Extract the .tar file to the current directory by typing:

# cd /opt/OV/newconfig/SiteScope

# tar -xvf DrillDownToSIS.tar

f. Upload the Drill Down to SiteScope tools to the HPOM server by typing:

# cd /opt/OV/bin/OpC/

# opccfgupld -replace -subentity /opt/OV/newconfig/SiteScope/

DrillDownToSIS

g. The Drill Down to SiteScope tools are available on the HPOM Administrator user interface
underBrowse > All Tool Groups.

h. AssignDrill Down to SiteScope tools to the opc_adm user.

o Click Action > Assign to User/Profile...

o Select All Users > opc_adm and click OK.

i. Update the HPOM user interface by selecting File > Reload Configuration.

j. The Drill Down to SiteScope tools are available on the HPOM server under Tools > Drill
Down to SiteScope tools.

3. Launch the tool (from the SiteScope service)
a. In the HPOM Administrator user interface, right-click the SiteScope service (server, group,

or monitor), select Start > Tools > Drill Down to SiteScope tools > Drill Down to
SiteScope service, and select the tool according to the service type selected.

b. The SiteScope user interface opens displaying the selectedmonitor, group, or default
SiteScope Dashboard view.

4. Launch the tool (from an event)
a. In the HPOM Administrator user interface, right-click an event and select Start > Drill

Down to SiteScope tools > Drill Down to SiteScope event.

b. The SiteScope user interface opens displaying the selectedmonitor that send the event.
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How to Enable the SiteScope Monitor
Discovery Policy

This task describes how to enhance the SiteScope integration with HPOM by enabling HPOM
Service Navigator to view SiteScope groups andmonitors in HPOM servicemaps.

Note:

l This task is part of a higher-level task. For details, see "How to Enable SiteScope to Send
Events to HPOM or OMi" on page 15.

l HPOM 9.0 forWindows 64-bit consoles support the services tree view with patch OMW_
00132 or later.

1. Copy policy files to the instrumentation folder
On the SiteScope server:

n ForWindows: Copy the discoverSiteScope.bat file from the <SiteScope root
directory>\integrations\om\bin folder to the%OvDataDir%\bin\instrumentation folder.

n For Linux, UNIX, Solaris: Copy all files from /opt/HP/SiteScope/integrations/om/bin/* to
the /var/opt/OV/bin/instrumentation folder.

Note: All relevant policy files can be found in the
<SiteScope root directory>\tools\OMIntegration\
SiteScopeMonitorDiscoveryPolicy\SiS_Discovery_policy_3.0 folder.

2. Upload the policy to the HPOM server (for HPOM for Windows servers)
Prerequisites:

n HPOM forWindows 8.16 (or an equivalent patched 8.10 server) or 9.10, and sufficient user
rights (typically, Administrator).

n All uploads are performed using the HPOM forWindows command line tool ovpmutil which
is normally in the environment path.

To upload the policy to the HPOM server:

a. Open a command prompt, and navigate to the folder where the SiteScope Discovery 3.0
server components are located. For example, C:\temp\SiS_Discovery_3.0:

cd C:\temp\SiS_Discovery_3.0\ForServer

b. Upload the ServiceModel using ovpmutil:

ovpmutil cfg svt upl .\DiscoverSiteScope.mof

The ServiceModel is displayed in the HPOM Service Type Configuration Editor (under
Application Services > SiteScope).

c. Upload the SiteScopemonitor discovery policy using ovpmutil and the provided index file:
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ovpmutil cfg pol upl .\PolicyConfig_77BFF2F6-38BD-45B3-BEA9-

E237C55F7877.xml

The policy is now available in the HPOM server policy repository underPolicy
management > Policy groups.

3. Upload the policy to the HPOM server (for HPOM for Linux, UNIX,
Solaris 9.x servers)
a. Upload the HPOM ServiceModel to the HPOMmanagement server. Open a command

shell and type:

/opt/OV/bin/OpC/utils/mof_cfgupld.sh /opt/HP/SiteScope/tools/\

SiS_Discovery_policy_3.0/ForServer/DiscoverSiteScope.mof

OMIntegration/SiteScopeMonitorDiscoveryPolicy/\

(The .mof file is located in the <SiteScope>/tools/OMIntegration/
SiteScopeMonitorDiscoveryPolicy/SiS_Discovery_policy_3.0/ForServer folder.)

b. Upload the policies by typing in a command shell:

/opt/OV/bin/OpC/utils/opcpolicy -upload dir=/opt/HP/SiteScope/\

tools/OMIntegration/SiteScopeMonitorDiscoveryPolicy/\

SiS_Discovery_policy_3.0/ForServer

c. Assign the policies to the node, and deploy to the SiteScope node by typing in a command
shell:

# /opt/OV/bin/OpC/utils/opcnode -assign_pol node_name=<NODENAME>

net_type=NETWORK_IP pol_name= "SiteScope Discovery" pol_

type=svcdisc

4. Set the Schedule Interval
You can set the schedule interval for running the SiteScopemonitor discovery policy on the
HPOM agent in the HPOM forWindows console.

a. Select Policy management > Policy groups > SiteScope Discovery. In the right pane,
right-click SiteScope Discovery and select All Tasks > Edit.

b. In the Service Auto-Discovery policy editor, select theSchedule tab and specify an
interval for running the SiteScopemonitor discovery policy on the HPOM agent in the
HPOM forWindows console.

5. Deploy the policy
Prerequisites:

n The HP Operations agent is running and connected (for details, see "How to Enable
SiteScope to Send Events to HPOM or OMi" on page 15).

n The SiteScope server to be integrated is set up as an HPOMmanaged node, and a
certificate has been granted. For details, see "Accept the agent connection request on the
HPOMmanagement server or BSMGateway/Web Processing server" on page 18.

n The SiteScopemonitor discovery policy has been uploaded to the SiteScope Discovery
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policy group (for details, see "Upload the policy to the HPOM server (for HPOM for
Windows servers)" on page 27 or "Upload the policy to the HPOM server (for HPOM for
Linux, UNIX, Solaris 9.x servers)" on previous page).

To deploy the policy for HPOM for Linux, UNIX, Solaris 9.x servers:

Open a command shell and type: # opcragt -dist <NODENAME>

To deploy the policy for HPOM for Windows servers:

a. Right-click theSiteScope Discovery policy and select All Tasks > Deploy on.

b. In the Deploy Policies on dialog box, select the SiteScope Server OM node from the
available managed nodes, and click OK. The deployment status is displayed in
Deployment jobs in the OMConsole.

c. To view the policy inventory of the node, right-click the SiteScope Server OM node under
Nodes, and select View > Policy Inventory.

d. The policy inventory is displayed in the right pane, showing all policies deployed to the
node.

6. Manually run the Monitor Discovery policy - optional
For testing or debugging purposes, it is useful to run the discovery manually. This can be done
using the ovagtrep command line tool on the SiteScope server HPOM agent node where the
policy is running.

To do so, run the following commands:

a. To force execution of the policy, run the command:

ovagtrep -run "SiteScope Discovery"

b. To force submittal to server, run the command:

ovagtrep -publish

c. For troubleshooting, use theSystem.txt file in the%OvDataDir%\log folder.

7. Drill down to the SiteScope user interface from HPOM - optional
You can also use the Drill Down to SiteScope tool to enable opening the SiteScope user
interface from themonitor or group service that was discovered by themonitor discovery policy
and added to the HPOM Service Navigator.

For details on enabling the tool for HPOM forWindows, see "How to Enable the Drill Down to
SiteScope Tool on HPOM forWindows" on page 24.

For details on enabling the tool for HPOM for UNIX/Linux/Solaris, see "How to Enable the Drill
Down to SiteScope Tool on HPOM for UNIX/Linux/Solaris" on page 25.

8. Troubleshooting
For troubleshooting, you can check the following files:

n System.txt file in the <SiteScope Server>\%OvDataDir%\log folder (for Linux:
<SiteScope Server>/var/opt/OV/log).

n agtrep.xml file in <SiteScope Server>\%OvDataDir%\datafiles folder (for Linux:
<SiteScope Server>/var/opt/OV/datafile) to see the discovered instances the agent
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knows about.

n <HPOM Server>\%OvShareDir%\server\log\OvSvcDiscServer.log to see what the
HPOM server receives.

How to Configure Common Event Mappings
for HPOM or BSM

This task describes how to use Common Event Mappings to configure event mappings for monitors
and alerts. This is themapping between SiteScope runtime data and the values of event attributes
that will be sent.

1. Prerequisites
n To create or make changes to event mappings, youmust be a SiteScope administrator user,

or a user grantedAdd, edit or delete common event mappings permissions. For details
on user permissions, see the section on user management preferences in the Using
SiteScopeGuide in the SiteScope Help.

n To select an event mapping when configuring an alert or amonitor instance:

o The HP Operations agent must be installed and connected to an HPOM or BSM server.
For details, see "Install the HP Operations agent on the SiteScope server" on page 15.

o Event integrationmust be enabled in the HP Operations Manager Integration dialog box
(InPreferences > Integration Preferences > HP Operations Manager Integration.
For details, see "Enable SiteScope to send events to HPOM or OMi" on page 20.

2. Configure the alerts or monitor instances
You configure the alerts or monitor instances that, where triggered, create the relevant events
in the event system.

For task details, see the alerts or monitors section in the Using SiteScopeGuide in the
SiteScope Help.

3. Configure the event mappings for an alert or monitor instance
You configure an event mapping tomap an alert or monitor instance to the corresponding event
attributes. You can create several mappings for each type of alert or monitor.

n You configure alerts from theAlerts tab > New/Edit Alert > HP Operations Manager
Integration Settings > Event mapping.

n You configure amonitor instance frommonitorProperties tab > Event Mapping Settings.

For each alert or monitor instance, you can use the default event mapping associated with the
monitor or alert, select a different event mapping (if any exist), or create a new event mapping
in Common Event Mappings. Alternatively, for alerts, you can use the event mapping template
associated with themonitor that triggered the alert.

To create or edit a mapping:

a. In the New/Edit Event Mappings dialog box, click theNew Event Mapping button, or

select an existing event and click theEdit Event Mapping button.
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b. In theMain Settings panel, enter a name to identify the common event and a description.

c. In theCommon Event Model Settings - General tab, you can use the default settings, or
edit them as necessary. For details, see "Common Event Model Settings - General Tab" on
page 46.

d. Use theCommon Event Model Settings - Custom Attributes tab to add attributes
which provide additional information about the event that is not provided in any of the other
common event attributes. A custom attribute consists of a key and a value (both are
strings). The value can be any string and is used by the common event mapping as any
other value. For details, see "Common Event Model Settings - Custom Attributes Tab" on
page 49.

4. Results
You can view the events corresponding to the triggered alerts or changes in amonitor's metric
status in the Event Console in HPOM, or in Operations Management in BSM (if you have an
Event Management Foundation license).

If Operations Management is not part of your BSM installation, you can view events that affect
CI status using a health indicator in Service Health.

For troubleshooting relating to the HP Operations agent installation, event integration setup,
sending events, and with node andmonitor discovery, see "Troubleshooting Event Integration
Issues" on page 40.

SiteScope Alert Template and Event
Properties Directory

The following common properties can be found or used in SiteScope alert templates, common
event mapping attributes, and in email reports.

This section includes:

l "Alert Template and Event Properties" below

l "Email Report Properties" on page 38

Alert Template and Event Properties

The following is a list of the common properties found in SiteScope alert templates and attributes
used in common event mappings.

Available Properties Description / Example
Included in
Templates

<_customPropertiesValues>

<_eventCategory> NTEventlog

<_httpPort> NTEventlog
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Available Properties Description / Example
Included in
Templates

<_webserverAddress> NTEventlog

<alert> XMLMail

<alertHelpURL> URL of the SiteScope help including the alert
topic

NoDetails

Traceroute

WithDiagnostic

<alert::name> The name of the alert

<alert::id> The alert ID

<alert::description> Text description for the alert definition

<alert::disableDescription> Description of the purpose of the disable
operation

<alert::actionID> The ID for the alert action

<alert::actionName> The name of the alert action

<all> All of the properties of themonitor

<allThresholds> Returns all the thresholds in themonitor in the
email alert

<automaticSeverityMapping>

<bacMonitorID> Themonitor's BSM ID

<bacSessionID> The BSM profileID

<category> Themonitor category Typical

<_classifier> Returns the first threshold in themonitor in the
email alert

<currentTime> The time that the alert is run

<diagnostic> XMLMail

<diagnosticText> Default User

NoDetails

WithDiagnostic

<diagnosticTraceRoute> Traceroute

WithDiagnostic

<errorCounterOnly> List of themonitor counters in error status
(returns counter name only)
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Available Properties Description / Example
Included in
Templates

<errorOnly> List of themonitor counters in error status
(returns counter name and counter value)

Typical

<etiType>

<etiValue>

<eventID> NTEventlog

<eventMachine> NTEventlog

<eventSource> NTEventlog

<eventType> NTEventlog

<firstgroupdescription>

<fullMonitorName>

<FullGroupId> Full path from the SiteScope root directory to
the group, exclude\SiteScope

<goodCounterOnly> List of themonitor counters in good status
(returns counter name only)

Typical

<goodOnly> List of themonitor counters in good status Typical

<group> Name of the group that themonitor is in AllErrors

Default

Default User

lr-Default_
mail_
template

NoDetails

NTEventlogt

PagerMail

ShortMail

Traceroute

Typical

WithDiagnostic

XMLMail

<group>.propertyname Property of the group that themonitor is in

<group>.<parent>. Property of the parent group of the group that
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Available Properties Description / Example
Included in
Templates

propertyname themonitor is in

<groupdescription> Group description

<groupID> ID of the group Default

Typical

WithDiagnostic

XMLMail

<id> XMLMail

<mainParameters> List of themainmonitor properties that are set
as parameter

Default

Default User

NTEventlog

WithDiagnostic

<mainStateProperties> List of mainmonitor properties that are set as
state properties. These are the result statistics
that are shown on the Reports.

Default

Default User

NTEventlog

WithDiagnostic

<metric>

<metricValue>

<monitorDrilldownURL> Creates a hyperlink in the event to themonitor
URL.

<monitor> XMLMail

<monitorName>

<monitorServiceId> Enables customizing the service name that is
sent from SiteScope events to HPOM by
entering the value of themonitor service ID.
This is useful for relating the SiteScope
monitor with the HPOM Service Name.

<monitorType>

<name> Name of themonitor

(same as _name)

Default

Default User

lr-Default_
mail_
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Available Properties Description / Example
Included in
Templates

template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

<newSiteScopeURL> URL of the SiteScope server Default

Typical

<newStatus> Current status of themetric

<oldStatus> Previous status of themetric

<processtext>

<remoteMachineName> Name of the remote server machine

<sample> Sample # AllErrors

Default

Default User

NoDetails

NTEventlog

PagerMail

ShortMail

Traceroute

Typical

Typical.mail

WithDiagnostic

XMLMail
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Available Properties Description / Example
Included in
Templates

<secondaryParameters> Lists themain state properties and other
internal properties

<secondaryStateProperties> Lists themain state properties and other
internal properties

<server> XMLMail

<sitescope> XMLMail

<sitescopeURL> The URL to themain page of SiteScope for
admin access

AllErrors

Default User

NoDetails

Traceroute

WithDiagnostic

<sitescopeuserurl> The URL to themain page of SiteScope for
user access

<state> Status string reported by themonitor

(same as stateString)

AllErrors

Default

Default User

lr-Default_
mail_
template

NoDetails

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

<tag> Tags of themonitor (if exists) Default

Default User

lr-Default_
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Available Properties Description / Example
Included in
Templates

mail_
template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

<tag:[tagName]> Displays the value or values of the
Search/Filter tag with the [tagName] assigned
to themonitor that triggered the alert.

Example:You have a tag named AppServer
with value Apache assigned to amonitor, and
you include <tag:AppServer> in the alert
template configured for that monitor. If an alert
is triggered, the new property is replaced with
Apache in the alert text.

<targetHost> Name of the target host

<templateDeployPath> Displays the path of the template group from
which themonitor was deployed.

<thresholdCrossed>

<time> Time that themonitor completed the last run AllErrors

Default

Default User

lr-Default_
mail_
template

NoDetails

NTEventlog

Traceroute
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Available Properties Description / Example
Included in
Templates

Typical

WithDiagnostic

XMLMail

<time-date> The date portion of the time that themonitor
completed

<time-time> The time portion of the time that themonitor
completed

<warningCounterOnly> List of themonitor counters in warning status
(returns counter name only)

<warningOnly> List of themonitor counters in warning status
(returns counter name and counter value)

Typical

Email Report Properties

The following properties are applicable to the email templates stored in the
<SiteScope>\templates.history directory:

Available Properties Description

_httpPort Port number used to access SiteScope

_webserverAddress IP address for the SiteScope Server

basicAlertSummary Basic information on what alerts have been triggered

detailAlert Summary More detailed information on alerts

reportIndexURL URL to the index page for themanagement report

reportPeriod Time period for this report

reportURL URL to the HTML version of themanagement report

summary Summary andmeasurement information

textReportURL URL to the comma-delimited file generated by SiteScope

userReportIndexURL URL to the index page for a user-accessible report

userTextReportURL URL to the comma-delimited file generated by a user-accessible report

userXMLReportURL URL to the XML file generated by a user-accessible report

xmlReportURL URL to the XML file generated by themanagement report
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Troubleshooting and Limitations
This section contains notes and limitations, and provides troubleshooting when using the
Operations Manager integration to send events directly to the HPOMmanagement server or to
Operations Management in BSM.

Notes and Limitations
l Upgrades for earlier SiteScope-HPOM event integration (pre-SiteScope 11.00) are not

supported.

l While SiteScope 10.x versions support HPOM event integration, events generated in SiteScope
versions earlier than 11.00 do not affect Service Health and Service Level Management in BSM
9.0x.

l If SiteScope is installed on the samemachine as HPOM, when uninstalling SiteScope you
should clear the option to uninstall the HP Operations agent.

l Sending events to HPOM using the HP Operations agent is available only when connected to
BSM 9.00 or later. Although the earlier HPOM integration solution of installing the HP SiteScope
Adaptor on the HPOMmanagement server is supported in earlier versions of SiteScope, it is not
supported with SiteScope11.00 or later and should be uninstalled. You should therefore upgrade
to the implementation using the HP Operations agent.

l If you are having problems activating node discovery or deploying themonitor discovery policy,
verify that the SiteScope node system properties are discovered correctly, and fix them if
necessary. In the Node Properties dialog box, select theSystem tab andmake sure the settings
matches you SiteScope node system settings.

l If you are using HP Operations Manager forWindows 9, patch OMW_00097/98 or later (32-
bit/64-bit) is required to support the Node discovery feature without overriding SiteScope node
properties.

l If you currently use HPOMwith SiteScope and you plan to upgrade HPOM to BSM, youmust
connect SiteScope directly to BSM to perform the upgrade. This also enables SiteScope to
report the topology to BSM. For details on connecting SiteScope to BSM, see section on
working with BSM in the Using SiteScopeGuide in the SiteScope Help..

l When SiteScope sends an event in which amonitor metric value does not match any of the
thresholds, the indicator severity Normal is sent to the HPOMmanagement/BSMGateway
Server.

l When SiteScope is connected to BSM, after amonitor is created on a new host, the event is
sent to Operations Management without the value of the related CI (the event is triggered before
topology is reported to BSM). To avoid waiting for the next event to be sent, select theManually
send first event check box in themonitor's HP Integration Settings > HP Operations
Manager Integration Settings. This action can be performed globally using Global Search and
Replace.

l If there are no ETIs from SiteScope in the Operations Management Event Browser, make sure
when configuring event integration that theBSM Service Health affected by setting inHP
Integration Settings > BSM Service Health Preferences is set toEvents. IfMetrics is
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selected, status change events reported by SiteScope do not have any influence on CIs in
Service Health or Operations Management.

l Events are not closed (relevant to HPOM and BSM) and the indicator status is not cleared
(relevant to BSM) if SiteScope stops monitoring in the following instances:

n The related SiteScopemonitor skipped or was disabled/suspended (permanently or by the
scheduler)

n The related SiteScopemonitor was deleted

n SiteScope stops reporting to BSM (for example, if it is disconnected)

l To exclude indicators of disabledmonitors from Service Health, Service Level Management, or
both, it is recommended to use DowntimeManagement in BSM 9.0x or later. For details, see the
section on downtimemanagement in the BSM Platform Administration Guide in the BSMHelp.

l For additional troubleshooting relating to the HP Operations agent installation, event integration
setup, sending events, and with node andmonitor discovery, see "Troubleshooting Event
Integration Issues" below.

Troubleshooting Event Integration Issues
This section includes:

l "Installation Problems" below

l "Integration Setup Problems" on next page

l "Problems Sending Events" on page 43

l "Node Discovery andMonitor Discovery Troubleshooting" on page 45

Tip:When referring to the integration log file, you can open it from the SiteScope user interface
(Server Statistics > Log files > HPSiteScopeOperationsManagerIntegration.log).

Installation Problems

Symptom:

An error occurred while running the HP Operations agent installation in the SiteScope Configuration
Wizard during SiteScope installation.

Troubleshooting:

1. Open the agent installation log, opc_inst.log, in the c:\Windows\Temp, /var/tmp (Solaris) or
/tmp (Linux) folder, and delete opc_inst.lock.

2. Refer to the SiteScope documentation tomake sure your operating system is supported for HP
Operations agent installation.

3. Run the SiteScope Configuration Tool, and install the HP Operations agent again (it is also
recommended to restart the server).

4. Run the SiteScope Configuration Tool, and uninstall the HP Operations agent and then install it
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again (it is also recommended to restart the server).

5. Manually reinstall the HP Operations agent (it is also recommended to restart the server).

On Windows:

a. Uninstall the agent from C:\Program Files\HP\HP BTO Software\bin\OpC\install.

b. Run the command: cscript opc_inst.vbs -remove -force

c. From the Control Panel, uninstall the HP Operations Integration Adapter Policy Activation
package.

d. Reinstall the agent from:<SiteScope root directory>\install\components\oa\<Operating
System>

e. Run the command: cscript opc_inst.vbs

f. Install <SiteScope root directory>\install\components\oa_policy_signing_
tool

On UNIX:

a. Run the command:
/opt/HP/SiteScope/install/components/oa/<operating_system>/opc_

inst -remove

where <operating_system> is either solaris, linux, or linux64.

b. Run the command:
/opt/HP/SiteScope/install/components/oa/<operating_system>/opc_

inst

c. For Solaris:

Run the command: /opt/HP/SiteScope/install/components/oa_policy_

signing_tool/

solaris pkgadd -a HPOprIAPA.admin -d HPOprIAPA-09.00.<version>-

SunOS5.10-release.sparc

For Linux:

Run the command: /opt/HP/SiteScope/install/components/oa_policy_
signing_tool/

rpm -i HPOprIAPA-09.00.<version>-Linux2.6-release.rpm

6. Put a new clean image on the system and install SiteScope and the HP Operations agent
again.

7. Contact your HPOM administrator for assistance.

Integration Setup Problems

Symptom:

Any problem that occurs while trying to configure the HP Operations Manager Integration (between
connecting the agent to the HPOM/BSM server and sending a test message).

Troubleshooting:
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1. In SiteScope, open the HP Operations Manager Integration dialog box panel (Preferences >
Integration Preferences > HP Operations Manager Integration).

2. In the HP Operations Manager IntegrationMain Settings pane, check theHP Operations
agent installation path.

a. Click theResolve Path button.

b. Make sure the agent is installed on the path you see in this field.

o If the agent is installed on a different path, update the path accordingly.

o If you do not see the path is resolved (probably the agent is not installed properly), try
restarting the server machine. If it does not help, follow the troubleshooting in "Installation
Problems" on page 40.

c. Make sure your HPOMmanagement server or BSMGateway host name is typed correctly
in the host field.

3. Click theAnalyze button.

a. If the command outputs are empty, there is a problem with the agent installation. Follow the
troubleshooting in "Installation Problems" on page 40.

b. Check that the bbcutil command output returns status=eServiceOK. If it does not, there
is a connectivity problem to your HPOMmanagement server and you should contact your
HPOM administrator for assistance.

c. Check the opcagt -status command output. You should see a few processes running
(some can be in Aborted state—this is fine at this stage). If they are not running, manually
start the agent by running command line: opcagt -start, or restart your server machine.

4. Make sure your HPOMmanagement server is up and running.

5. If you are working with BSM, check your Gateway and Data Processing Server. Run
command line ovc -status. Make sure all processes are running (in particular, the
"Certificate Broker") if they do not start with ovc -start.

6. If you are working with a distributed BSM environment (in BSM 9.00 or later), follow the
procedures for initiating trust between your Gateway and Data Processing Server, and
forwarding the certificate request from theGateway to the Data Processing Server. For details,
see "How to Enable SiteScope to Send Events to HPOM or OMi" on page 15.

7. Click theConnect button, andmake sure the command output returns: opcactivate
Info: Successfully activated OVO agent.

If it does not, contact your HPOM administrator for assistance.

8. Accept the certificate request.

n When connecting to a BSM server, follow the step for accepting the agent connection
request in "How to Enable SiteScope to Send Events to HPOM or OMi" on page 15.

n When connecting to an HPOMmanagement server, consult your HPOM administrator. If you
do not see the certificate request, contact your HPOM administrator.

9. Click theAnalyze button.
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a. Make sure the ovcert -check is ok, and it ends with "Check Succeeded".

b. Make sure ovcert -list lists some certificates.

c. If there are problems with the command outputs:

o Contact your HPOM administrator, or

o Start the integration process troubleshooting from the connect phase, or even reinstall the
agent.

10. Click the Install Policies button.

a. If you get an error here or this process is stuck with "please wait" and:

o You recently reinstalled the agent and did not restart yet, restart your server.

o Otherwise, there is a problem with the agent (and the additional policy activation tool
package) installation. Reinstall on a clean image.

b. Click theAnalyze button, or check the output of the Install Policies for the list of policies.
Make sure you see the following list with all enabled:

o HP_SiteScope_to_Operations_Manager_Integration_by_Log_File

o HP_SiteScope_to_Operations_Manager_Integration

o SiteScope_Hosts_Discovery

11. In the Test Message box, type amessage and click Send test message.

a. Check your HPOM Event Console or Operations Management Event Browser.

b. If you do not see themessage in the Event Console/Browser:

o Run command line: opcmsg a=a o=o msg_t=xxx

o If the command is not available, something went wrong with the process so far (either the
certificate or the policies does not work). Try to install the policies again, and if the same
problem occurs contact HP Software Support.

o If the command is executed but you still do not see themessage in the Event Console,
contact your HPOM administrator for support.

Problems Sending Events

Symptom 1:

Sending a test event from the HP Operations Manager Integration dialog box does not reach the
HPOM Event Console/Operations Management Event Browser.

Troubleshooting:

1. In the HP Operations Manager Integration dialog box, enter a test message in the Test
message box, and click Send test message. If the test message is not displayed in the Event
Console, follow all the steps in "Integration Setup Problems" on page 41, and then try again.

2. Click theAnalyze button, andmake sure all commands are successful (in particular, see the
list of policies installed). For details, see "Integration Setup Problems" on page 41.
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3. Click theSend Test Event button.

4. In the <SiteScope root directory>\logs directory, check the events log file,
HPSiteScopeOperationsManagerIntegration.log. Verify the event entry in the log file. If you
do not see it, contact HP Software Support.

5. If you still do not see the event in the HPOM Event Console/Operations Management Event
Browser, check you are viewing the correct node in HPOM, or are not filtering out anything in
the Operations Management Event Browser. If you still do not see the event, contact HP
Software Support.

6. Open the <SiteScope root directory>\tools\OMIntegration\Policies\F516CEC3-3AD4-
4627-9CFD-BB155B894349_data file, and check that the path specified for
HPSiteScopeOperationsManagerIntegration.log is correct (it might use an environment
variable). If youmake any changes here, youmust install the policies again.

Symptom 2:

Themetric status change or alert event is not displayed in the HPOM Event Console/Operations
Management Event Browser.

Troubleshooting:

1. Check if the test event is displayed in the Event Console/Browser. If it is not displayed, follow
the guidelines for Symptom 1 in "Problems Sending Events" on previous page above.

2. Check that event integration is enabled in themonitor or alert configuration settings. Change
themonitor metric status, or trigger an alert. In the <SiteScope root directory>\logs
directory, check the events log file, HPSiteScopeOperationsManagerIntegration.log.

3. If you do not see the event entry in the log file, check you enabled event integration correctly in
themonitor or alert you are running (for details, see "How to Enable SiteScope to Send Events
to HPOM or OMi" on page 15). If it is still not in the log file, contact HP Software Support.

4. If you see the event entry in the log file, but not in the Event Console/Browser:

a. Check that no filter is set in the Event Browser.

b. If it is a newly-createdmonitor, and you are filtering the related CI in Operations
Management, it is possible that the CI topology is not reported yet. Try again in a few
minutes.

c. In HPOM legacy, make sure the event target node exists on your console.

d. Contact HP Software Support.

Symptom 3:

You see themetric or alert event in the Operations Management Event Browser, but it has no
related CI or HI, or Indicator state or severity.

Troubleshooting:

1. Check the event attribute values in theHPSiteScopeOperationsManagerIntegration.log file
located in the <SiteScope root directory>\logs directory. Look for the HI (ETI) and CI hint.
They should look like this: CPULoad:High:80 and SiteScope:3:123456 respectively.
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a. To know the attribute order in this tab separated values line, you can send a test event
before this event and compare the lines. The test event writes the name of each attribute in
its order.

b. If the CI Hint or HI hint are unknown, empty, or look different than the example, there is a
problem with the SiteScope configuration.

o Check that the SiteScope is registered to BSM.

o Check that themonitor thresholds have indicator states assigned to them, or that your
alert has some ETI and ETI state set.

o Check the preference setting for reporting SiteScope data in themonitor configuration is
set toEvents (inHP Integration Settings > BSM Service Health Preferences).

2. If everything looks fine in the log file in SiteScope, open the event in the Operations
Management Event Browser.

a. In theGeneral tab, check the related CI attribute. If you do not see the related CI, select
theResolver tab and check theStatus field.

o Check if there is information about the CI resolution failure.

o Check that themonitor topology is available in the BSM (you can check this in the
System Hardware or SystemMonitors views).

Note: If this is a newly-createdmonitor, it will take few minutes for the topology to
arrive and the event to be assigned with a related CI.

b. In theGeneral tab, if you see the related CI but Event Type Indicator is empty:

o Select theResolver tab and check the ETI Hint attribute value sent by SiteScope. If it is
empty or unknown, check your SiteScope configuration.

o If the value exists but does not show up inEvent Type Indicator in the General tab,
there was a problem when applying the indicator to the CI. Check Service Health or
Operations Management for support.

Node Discovery and Monitor Discovery Troubleshooting

Node Discovery:

l If you are using HP Operations Manager forWindows 8.1x, patch OMW_00071 is required to
support the Node discovery feature in SiteScope-HPOM event integration.

l If you are using HP Operations Manager forWindows 9, patch OMW_00097/98 or later (32-
bit/64-bit) is required to support the Node discovery feature without overriding SiteScope node
properties.

l If you are using HP Operations Manager for Solaris/HP-UX/Linux 9.10, patch 9.10.200 is
required to support the Node discovery feature in SiteScope-HPOM event integration.

Problems with Node discovery:

1. Click theAnalyze button in the HP Operations Manager Integration dialog box. Make sure you
see theSiteScope_Hosts_Discovery policy installed and enabled.
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2. Check that your event configuration is set. Send a test event andmake sure you see it in the
HPOM Event Console on the SiteScope node.

New nodes are reported within 5minutes from the time they started to beingmonitored by
SiteScopemonitors.

The discovery policy runs SiteScope scripts that generate XML consumed by the policy. Each
run is logged in the following log:%OvDataDir%\log\System.txt (for Linux <SiteScope
Server>/var/opt/OV/log).

3. You can invoke the process manually, by running the following commands:

ovagtrep -run "SiteScope_Hosts_Discovery"ovagtrep -publish

Monitor Discovery:

To enable HPOM Service Navigator to view SiteScope groups andmonitors in HPOM service
maps, follow the configuration instructions in "How to Enable the SiteScopeMonitor Discovery
Policy" on page 27.

Common Event Mappings User interface
The New/Edit Event Mappings dialog box enables you to create new common event mappings or
edit existingmappings. These aremappings between SiteScope runtime data and the attribute
values that are used for sending events. Common event mappings are used when configuring the
Operations Manager event integration and theGeneric Event integration.

Common Event Model Settings - General Tab
User interface elements are described below

UI Element Description

General

Title Descriptive text describing the occurrence represented by the event. This should
include information about what threshold has been crossed (or other trigger
conditions), and the current values.

Default value:

l For status changemetrics:
Metric '<<metric>>' changed status from '<<oldStatus>>' to
'<<newStatus>>'

l For alerts:
Alert '<<alertName>>' was fired onmonitor '<<fullMonitorName>>' status
change

Tip:Since the text is typically shownwithin a single line in the event browser, it
is recommended to put themost relevant information at the beginning.

Description Additional information describing the event.

Default value:
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UI Element Description

l For status changemetrics:
Metric '<<metric>>' crossed '<<thresholdCrossed>>' with value
'<<metricValue>>'

l For alerts:
Monitor '<<fullMonitorName>>' changed status from '<<oldStatus>>' to
'<<newStatus>>'

Severity Severity of the occurrence related to the event. The severity level can be
Unknown, Normal, Warning, Minor, Major, or Critical.

Default value: <<severity>>. The <<severity>> attribute is replaced by the
severity in the Indicator State and Severity field in the Threshold Settings for
the selectedmonitor metric.

Category Value used for organizing or grouping events by monitor type.

Default value: <<monitorType>>

Examples:Database, Application, J2EE

Subcategory Value used for organizing or grouping events that have the same category.

Default value:

l For status changemetrics: <<metric>>

l For alerts: <<fullMonitorName>>

Example:Oracle

Log only If True is selected, enables submitting an event that goes directly into the history
event browser as a closed event. Such an event goes through the complete
event processing, but has its Life Cycle State set to close from the beginning.

Typical examples are events that result in resetting an indicator to a normal or
good state, or an event signaling that a previous problem no longer exists (where
the problem was reported in another event).

If True for normal severity is selected, all messages forwarded from
SiteScope to HPOM are sent to theAcknowledgedmessage browser (instead
of theActivemessage browser) if their severity is normal. This prevents the
Activemessage browser becoming unnecessarily cluttered with normal severity
messages.

Default value: False

Event Type
Indicator

Link between the event and the indicator so that information about the indicator
can be updated as a result of submitting the event.

Default value:

l For status changemetrics: <<etiType>>:<<etiValue>>:<<metricValue>>

l For alerts: <<etiType>>:<<etiValue>>
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UI Element Description

Example of metric status change: CPU Load:High:90

Note: This field is mandatory for updating the indicator. It is not recommended to
change the template value of this attribute.

Correlation

Key A unique string representing the type of event that occurred. Two events can
have the same key if both events represent the same situation in themanaged
environment. Duplicate events are discarded after the number of duplicate
events is increased in the "Number of Duplicates" count.

Default value:

l For status changemetrics:
<<siteScopeHost>>:<<monitorUUID>>:<<metric>>:<<etiValue>>:
<<severity>>

l For alerts:
<<siteScopeHost>>:<<fullgroupid>>:<<monitorName>>:<<alertName>>:
<<etiValue>>

Example of metric status change:

labmachine1:OMEventIntegration:CPU Utilization on SiteScope Server:
utilization:Good

Submit
close key
condition

Enables the close key pattern to be evaluated by the event subsystem. If
selected, enter the pattern in theClose key pattern box below.

Default value:Selected

Close key
pattern

(This box is available only if Submit close key condition is selected.) Enables the
event that is sent to automatically close all the events whose key attribute
matches this expression. It is recommended that this field contain the same
value as in the Key field.

Note: SiteScope event integration policy always adds "<*>" to the end of your
close key pattern. The "<" and ">" signs cannot be used here since that they
cannot be interpreted by the log file policy.

Default value:
<<siteScopeHost>>:<<fullgroupid>>:<<monitorName>>:<<metric>>

Example: labmachine1:OMEventIntegration:CPU Utilization on SiteScope
Server:utilization<*>

Advanced Parameters

CI hint Information about the CI that is related to the event. This attribute is used for
providing hints to enable the event processing to find the correct related CI
(RTSM ID of the related CI).

Default value: <<ciHint>>. The value in this field varies, depending on whether
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UI Element Description

SiteScope is connected to BSM or HPOM. This field is not editable.

Host hint The target host beingmonitored by themonitor that triggered the event. The
value is translated to the legacy node attribute in HPOM. If the node does not
exist in HPOM, the event will be lost.

Default value: <<targetHost>>

Examples:

l IPv4: 15.15.12.13,

l DNS: host1.hp.com

Generating
source hint

Information about themonitoring application and the corresponding probe/agent
that is responsible for creating the event.

Default value:SiteScope@@<<siteScopeHost>>

Example: SiteScope@@host1.hp.com

Attributes

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by
dragging it from theAttributes list to the selected text box, or select the cell in
which to copy the selected attribute, and click Ctrl+I.

For a description of the available attribute variables, see "SiteScope Alert
Template and Event Properties Directory" on page 31.

Common Event Model Settings - Custom Attributes Tab
User interface elements are described below

UI Element Description

Enables creating a new custom attribute for the event. Each event can have any
number of custom attributes.

l New Key. Adds a new line to the table, enabling you to add a name and value
for the attribute.

l Known Key. Opens a submenu with the known keys as options. You can
select the relevant key. A new row opens in the Name/Value table, with the
name of the selected key in the Name column. You can then enter the value of
the key in the corresponding Value column.

Delete Custom Attribute. Deletes the selected custom attribute from the table.

Name and
Value

Each event can have any number of custom attributes. Custom attributes can be
used to provide additional information with the event that is not provided in any of
the other common event attributes or that is contained in any of the other
attributes. Each custom attribute is aName-Value pair, where you enter the name
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UI Element Description

of the attribute in theName field and the value of the attribute in theValue field.

This featuremay be used when youmanage the environment of multiple
customers using one instance of the product. Themultiple customers might be
handled by a custom attribute object.

Example:Name = "cma1" ; Value = "XYZ Company"

Note:Make sure that the name of the attribute you are defining is unique and does
not already exist in the attributes list.

Attributes

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by
dragging it from theAttributes list to the selected box, or select the cell in which to
copy the selected attribute, and click Ctrl+I.

For a description of the available attribute variables, see "SiteScope Alert
Template and Event Properties Directory" on page 31.

HP CDA Event Mapping template

This is an out-of-the-box template that is specially configured for CDA (Continuous
Delivery Automation). CDA is a policy-based platform that provides infrastructure
provisioning in hybrid cloud environments. CDA integrates with SiteScope to
deploy SiteScopemonitors and receive events from them. Monitoring status
based on the events received is available in the CDA user interface. For more
details on CDA, refer to the CDA documentation.

The following attributes are included in the Custom Attributes tab for the HP CDA
Event Mapping template which is included by default in Common Event Mappings:

l <<TemplateDeployPath>>. Displays the full path to the template group from
which themonitor was deployed.

l <<monitorServiceId>>. (see below)

l <<monitorDrilldownURL>>. Creates a hyperlink in the event to themonitor
URL.

l <<newStatus>>. Current status of themetric.

Service ID Enables customizing the service name that is sent from SiteScope events to
HPOM by entering the value of themonitor service ID. This is useful for relating
the SiteScopemonitor with the HPOM Service Name.

Default value: <<monitorServiceId>>
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Configuring SiteScope to Report Metrics
to HPOM and OMi

SiteScope uses the HP Operations agent to make its metrics data available to HP Performance
Manager (the reporting component of HPOM) and to PerformanceGraphing in BSM's Operations
Management. To enable SiteScopemetrics to be collected by these reporting products, the
HP Operations agent must be installed on the SiteScope server. SiteScope collects metrics data,
and logs it to the agent data store on the SiteScope host.

When a user in PerformanceManager draws or designs a graph, PerformanceManager collects
metrics data from the agent data store for the selected node in PerformanceManager that is
monitored by SiteScope, and draws the graph. Agentless graphing is supported in Performance
Manager 9.0 or later. For details on PerformanceManager, refer to the PerformanceManager
documentation. Metrics data collected from SiteScope can also be used in PerformanceGraphing.

Sizing is important for planning themaximum number of monitors, metrics, andmonitors types that
can be stored within the SiteScope-HPOMmetrics integration. For sizing recommendations, see
"Sizing Recommendations for SiteScope-Operations Manager Metrics Integration" on page 57.

Metrics name alignment, the process of aligningmetrics names in SiteScope with those used in
HPOM or BSM, has been performed for some of themost commonly usedmonitors. For details,
see "SiteScope-Operations Agent Metrics Alignment" on page 54. PerformanceManager can graph
any metrics (whether aligned or not), andmetrics alignment for all possible metrics is not required
for viewing the data in PerformanceManager.

For details on configuringmetrics integration, see "How to Enable SiteScope to Report Metrics to
the HP Operations Agent" on next page.

Note:

l Metrics integration using the HP Operations agent should not be confused with the
integration of SiteScopemonitor metrics used by the various BSM applications when
calculating status for CIs (for example, in Service Health, Service Level Management, and
System Availability Management). For details on BSMmetrics integration, see theWorking
with BSM section of the Using SiteScopeGuide in the SiteScope Help.

l Metrics integration with PerformanceManager can be activated regardless of the
connection status between the HP Operations agent and the HPOM or BSM server, since
metrics are collected by the agent.

l TheOperations Manager metrics integration is supported by SiteScopes running on
Windows and UNIX platforms for HPOM andOperations Management.

Tip: For best practices and troubleshooting for reportingmetrics data to BSM andHPOM
products using the HP Operations agent, see the Integration with BSM andHPOM Best
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Practices guide in the SiteScope Help.

Metrics Data Flow Diagram
The following diagram illustrates themetrics data flow:

How to Enable SiteScope to Report Metrics to
the HP Operations Agent

This task describes how to enable SiteScope to report metrics data to HPOM and BSM reporting
products.

1. Prerequisites
n Your systemmust conform to the following requirements:

o SiteScope version 11.00 or later is installed.

o For OMi, BSM 9.00 or later is installed.
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o For HPOM, HP PerformanceManager 9.0 or later is installed.

Note: The node discovery, monitor discovery, and template integration are not
supported for all versions of HPOM. For details of the integrations that are supported
and of any patch requirements, refer to the HP Operations Manager (HPOM)
Integration Support Matrix in the SiteScope release notes. (Available from the HP
Product Manuals site (http://support.openview.hp.com/selfsolve/manuals).

n Only a SiteScope administrator user, or a user grantedEdit integration preferences
permissions. can configure the integration. For details on user permissions, see the section
on user management preferences in the Using SiteScopeGuide in the SiteScope Help.

n The PerformanceManager administrator must configure PerformanceManager to connect
to the SiteScope node where the SiteScope instance is logging data. For details, refer to the
PerformanceManager documentation.

2. Install the HP Operations agent on the SiteScope server
You can install the HP Operations agent during or after a SiteScope installation from the
SiteScope installationmedia. The agent enables SiteScope to act as data storage for metrics
data collected by SiteScope.

For the supported HP Operations agent versions (and prerequisites), refer to the HP SiteScope
Support Matrices section in the SiteScope release notes.

For details on installing the HP Operations agent, see the section on installing SiteScope in
the HP SiteScope Deployment Guide.

3. Enable SiteScope to send metrics
InPreferences > Integration Preferences, select an existing Operations Manager integration
or click HP Operations Manager Integration to create a new integration. In the HP
Operations Manager Integration dialog box, expand theHP Operations Manager Metrics
Integration panel and select Enable HP Operations Manager metrics integration.

Note: Metrics integration with HP Operations Manager can be activated regardless of the
connection status between the HP Operations agent and the HPOM/BSM server, since
metrics are collected by the agent.

4. Enable monitor instances to send metrics
For eachmonitor instance that you want to report metrics data to the agent data storage,
expandHP Integration Settings in themonitor properties, and select Report metrics to HP
Operations agent in theHP Operations Manager Integration Settings section.

Tip: You can automatically enablemetrics reporting for particular monitor types without
having to select Report metrics to HP Operations agent for eachmonitor instance. To
do so, select Integration Preferences > HP Operations Manager Integration, expand
theHP Operations Manager Metrics Integration panel, and:

n Select Enable metrics reporting for new monitors to enable SiteScope to report
metrics to the HP Operations agent for all newly-createdmonitors.
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n Click theEnable metrics reporting for specific monitors button to enable reporting
metrics for Memory, CPU, Disk Space, andWindows Resources monitors only.

5. Results
Eachmonitor metric is logged as an instance by the agent on the SiteScope host node, with
the time and host as the instance identifier. Themetrics data is collected from the agent data
storage by HPOM and BSM for use in the reporting products.

Metrics error data is written to the oa_metric_integration.log file which is found in the
<SiteScope root directory>\logs directory.

For notes and limitations onmetrics integrations, see "Notes and Limitations" on page 59.

For troubleshootingmetrics integration issues, see "TroubleshootingMetrics Integration
Issues" on page 59.

SiteScope-Operations Agent Metrics
Alignment

Metrics name alignment is the process of aligningmetrics names in SiteScope with those used by
Operations Manager Performance Agent (PA). PerformanceManager can graph any metrics
(whether aligned or not), andmetrics alignment for all possible metrics is not required for viewing
the data in PerformanceManager.
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Metrics name alignment has been performed for the commonly usedmetrics listed below.

Note: Formore information onmetrics provided by Performance Agent, refer to the
HP Performance Agent Metric Help Viewer in the Performance Agent 5.0 documentation
(http://support.openview.hp.com/selfsolve/document/KM864772/binary/
PA5_MetricHelpView.html?searchIdentifier=-
65c7a852:127e60d1b54:6921&resultType=document). To enter the HP Software Self-solve
Knowledge Base, youmust log on with your HP Passport ID.

PA Metrics Name

(Display Name) SiteScope Metrics Name

BYCPU_CPU_TOTAL_
UTIL

(Total CPU%)

Windows:
l CPU Monitor \utilization (cpu #1, cpu #2, etc)

l Microsoft Windows Resources Monitor \Processor\{instance}%\
Processor Time

Linux:UNIX Resources Monitor \Processor\{instance}\System

HP-UX:N/A

Solaris:N/A

AIX: UNIX Resources Monitor \Processor\{instance}\%sys

BYNETIF_IN_BYTE_
RATE

(In KB Rate)

Windows:Microsoft Windows Resources Monitor \Network
Interface\{instance}\Bytes Received\sec

Linux:N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYNETIF_OUT_BYTE_
RATE

(Out KB Rate)

Windows:Microsoft Windows Resources Monitor \Network
Interface\{instance}\Bytes Sent\sec

Linux:N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_PHYS_READ_
BYTE_RATE

(Phys Read KB Rate)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Read Bytes\sec

Linux: N/A

HP-UX:N/A

Solaris:N/A
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PA Metrics Name

(Display Name) SiteScope Metrics Name

AIX: N/A

BYDSK_PHYS_WRITE_
BYTE_RATE

(Phys Write KB Rate)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Write Bytes\sec

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_REQUEST_
QUEUE

(ReqQueue)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\Avg. Disk Queue Length

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_UTIL

(Disk %)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Time

Linux: N/A

HP-UX:UNIX Resources Monitor \Block device
activity\<device>\%busy

Solaris:UNIX Resources Monitor \Block device
activity\<device>\%busy

AIX: UNIX Resources Monitor\Block device
activity\<device>\%busy

FS_SPACE_UTIL

(Space%)

Windows:Disk SpaceMonitor \percent full

Linux: Disk SpaceMonitor \percent full

HP-UX:Disk SpaceMonitor \percent full

Solaris:Disk SpaceMonitor \percent full

AIX: Disk SpaceMonitor \percent full

GBL_CPU_TOTAL_UTIL

(CPU %)

Windows:
l CPU Monitor \utilization (avgas)

l Microsoft Windows Resources Monitor \Processor\_Total\%
Processor Time

Linux: UNIX Resources Monitor \Processor\Total\System
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PA Metrics Name

(Display Name) SiteScope Metrics Name

HP-UX:N/A

Solaris:N/A

AIX: UNIX Resources Monitor\Processor\Total\%sys

GBL_MEM_PAGEOUT_
RATE

(PgOut Rate)

Windows:Microsoft Windows Resources Monitor \Memory\Pages
Output/sec

Linux: N/A

HP-UX:N/A

Solaris:UNIX Resources Monitor \Page-out memory andmemory
freeing activities\ppgout/s

AIX: N/A

GBL_MEM_UTIL

(Memory %)

Windows:Memory Monitor \percent used

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

GBL_SWAP_SPACE_
UTIL

(Swap%)

Windows:Microsoft Windows Resources Monitor \Memory\%
Committed Bytes In Use

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

Sizing Recommendations for SiteScope-
Operations Manager Metrics Integration

While the default SiteScope configuration enables running thousands of monitors, sizing is
important for planning themaximum number of monitors, metrics, andmonitors types that can be
stored within the SiteScope-HPOMmetrics integration.

The sizing should not exceed:

l Maximum insertion rate of 1000metrics per minute.

l Total retention storage of 1 GB.

l Total retention period of 5 weeks.
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Definitions

The following are definitions of the terms used in the validation calculations below:

l Monitors. The number of monitors that report metrics to HPOM PerformanceManager.

l Metrics. The average number of metrics of the abovementionedmonitors that report to HPOM
PerformanceManager.

l Frequency. The average frequency at which the abovementionedmonitors feed data into the
integration.

Validation

When choosing the specific SiteScopemonitors andmetrics to store within the SiteScope-HPOM
metrics integration, you should validate that the insertion and retention rates do not exceed the
recommendations. You can do that using the formulae below:

l Supported Insertion Rate Validation:

(Monitors * Metrics) / Frequency <= 1000 metrics/minute

l Supported Retention Period Validation:

(1000 MB) / ((Monitors * Metrics / Frequency) * 0.07 MB) =

configured retention period in days

(which should be less than themaximum retention period of 5 weeks)

where 0.07 MB is the storage size for eachmetric/minute per day.

Example

If you have 2500monitors that report data using the HPOMmetrics integration, and every monitor
has 4metrics, the frequency of thesemonitors is every 10minutes, and the averagemetric storage
size per day is 0.07MB, you will be able to store your historical data for 14 days.

Validation calculations:

l Insertion Rate Validation:

(2500monitors * 4metrics) / 10minutes = 1000 <= 1000metrics/minute

l Retention Period Validation:

1000MB / (((2500 * 4Metrics) / 10minutes) * 0.07MB) = 14.28 days (<= 5 weeks)

Troubleshooting and Limitations
This section contains notes and limitations, and provides troubleshooting when using the HP
Operations Manager integration tomake SiteScopemetrics data available to PerformanceManager
or to PerformanceGraphing in Operations Management.
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Notes and Limitations
l The agent data store supports only alphanumeric and the underscore (_) character in SiteScope

metric names. All other characters are converted to supported characters (themetric display
name (heading) remains in the SiteScope style).

l WebScript monitor data cannot be reported to Operations Management or HPOM.

l After upgrading from PerformanceManager to PerformanceGraphing and connecting SiteScope
to BSM, historical report data cannot be upgraded since it does not have CI-based reporting
capability (it can still be viewed in the old PerformanceManager way).

l To enable reporting numerical values with postfixes (such as 25% or 400MB) to the agent data
store, add the list of postfixes, separated by commas, to the _
omMetricIntergationAllowedNumberPostfixs property in the <SiteScope root
directory>\groups\master.config file. For example, to include%, MB, KB, andGB, add =%,
mb,kb,gb. Note that all postfixes should be in lower case.

l In anOperations Management Manager of Managers configuration (wheremultiple HPOM
servers are connected to Operations Management, andmultiple SiteScopes are connected to
the HPOM servers, and indirectly to Operations Management), data sent from SiteScope is not
supported by PerformanceGraphing, since SiteScope does not send topology to Operations
Management. For details on Operations Management deployment configurations, see the
section on Connected Servers in the BSM Application Administration Guide.

l To prevent overloading the agent data store, follow the sizing recommendations as described in
"Sizing Recommendations for SiteScope-Operations Manager Metrics Integration" on page 57.

Troubleshooting Metrics Integration Issues
This section includes:

l "SiteScope and HP Operations Agent Configuration" below

l "Health Monitors Errors" on page 61

l "HP PerformanceManager Configuration" on page 61

l "CI Resolution does not work ("BadHint error" in the cir_enrichment.log)" on page 61

l "System runs out of ports when reporting data to the HP Operations agent" on page 61

SiteScope and HP Operations Agent Configuration

Check the HP Operations Agent Configuration

1. Check the status of the HP Operations agent installed on the SiteScope server status by
running the following command: opcagt -status

The expected output is:
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If opcacta or opcmsgi are not running, try to restart the agent by running:

opcagt -stop

opcagt -start

2. Select Preferences > Integration Preferences, and select an existing or create a new
HP Operations Manager Integration. Verify that theEnable sending events check box is
selected.

3. In the HP Integration Settings for themonitor, Verify that theReport metrics to HP
Operations agent check box is selected.

4. Run themonitor, and wait for about aminute.

5. Run the following command to check if the agent data store contains the data:

set CODAMAGIC=0X05201993

ovcodautil -obj -ds AGENTLESS

You should receive object names from AGENTLESS data source (similar to the following):

6. To dump the summarized last record for AGENTLESS data source, run the following
command:

ovcodautil -dumpds AGENTLESS

Check the Relevant SiteScope Logs

Check the following logs that are available from the <SiteScope root directory>\logs directory:

l error.log

l RunMonitor.log

l om_metric_integration.log

l data_integration.log
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Health Monitors Errors

In the SiteScopemonitor tree, expandHealth and click Log Event Checker.

l If the Failed to report data to HP OM Agent counter is in error, SiteScope failed to connect or
report data to the HP Operations agent using Java API. For more information, see the oa_
metric_integration.log file in the <SiteScope root directory>\logs directory.

l If theGeneric Data Integration queue exceeded allowed size counter is in error, the queue of
metrics waiting to be sent is oversized and somemetrics were dropped tomaintain SiteScope
stability. For more information, data_integration.log file in the <SiteScope root
directory>\logs directory.

HP Performance Manager Configuration

1. On the PerformanceManager server, open theOVPMconfig.ini file in the
%ovdatadir%\shared\server\conf\perf directory.

2. Update the SiteScope server details as follows:

n [SITESCOPE]

n SERVER = servername

n NODEGROUP = Agentless

3. Restart the HP Openview Tomcat(B) service.

CI Resolution does not work ("BadHint error" in the cir_enrichment.log)

1. Go toAdmin > Platform > Infrastructure Setting.

2. In theApplication dropdown, select End User/System Availability Management.

3. In theSiteScope CI Resolver Settings, check for TQL Queries value.

The default value is CIs Monitored by SiteScope.

4. Go toAdmin > RTSM Administration and check forCIs Monitored by SiteScope query
results. If you do not get the requested CI in the query results, CI resolution will not find it as
well.

Possible problem: CI has missing attributes orthe SiteScopemonitor CI is not connected to
any monitored CI.

System runs out of ports when reporting data to the HP Operations agent

Problem: The system runs out of ports when reportingmetrics data to the HP Operations Agent in
a loaded environment.

l In SiteScope Health, an error is displayed in the Log Event Checker monitor for the .*Failed to
report data to HP OM Agent.* counter.

l In the oa_metric_integration.log, the following error is displayed: "ERROR - Failed to report
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data to /Hewlett-Packard/OpenView/Coda/ IO error while gettingSingle Object;Address already
in use: connect".

Possible solution: Increase the upper range of ephemeral ports and reduce the client TCP/IP
socket connection timeout value inWindows. For details, see http://msdn.microsoft.com/en-
us/library/aa560610%28v=bts.20%29.aspx.
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